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1 Legal information 
By downloading and/or installing the TScratch software (referred to below as 
SOFTWARE), you agree to the following license agreement. 

• The Koumoutsakos group at ETH Zurich (from here on referred to as the CSELab), 
agrees that the LICENSEE uses the SOFTWARE for scientific, non-profit and non-
commercial purposes only. SOFTWARE shall mean all SOFTWARE provided by 
CSELab, including any derivatives thereof. The software is intellectual property of 
CSELab and all rights, title and interest, including copyright, remain with CSELab. 

• The LICENSEE will not copy, distribute, reproduce, manufacture, alter, sell or sub-
license the SOFTWARE. The SOFTWARE will be used in accordance with all 
applicable laws and regulations. Any other use or exploitation (including distribution 
or sale) of the SOFTWARE requires the prior written permission of CSELab, which 
may demand compensation from the LICENSEE. 

• Nothing in this agreement shall be construed as granting any license under any 
intellectual property right vested into CSELab or any right to use the SOFTWARE or 
any CSELab information other than herein expressly specified. 

• The LICENSEE including any of its workers, co-workers, students or other persons 
who may have access to the SOFTWARE or related information agree not to transfer, 
transmit, distribute or in any other way disclose the SOFTWARE or information 
about its algorithms and/or implementations to third parties without prior written 
consent of CSELab. 

• In any publications resulting from research done under the use of the SOFTWARE, 
the LICENSEE will properly cite either party's contribution. Any report or 
publication of results obtained with the SOFTWARE will acknowledge its use by 
stating that SOFTWARE « was developed by the Koumoutsakos group (CSE Lab), at 
ETH Zürich ». Any published work that utilizes the SOFTWARE shall include the 
following reference: 

o Gebäck, T., Schulz, M.M.P., Koumoutsakos, P. & Detmar, M. A novel and 
simple software tool for automated analysis of monolayer wound healing 
assays. BioTechniques (2008). 

• Electronic documents will include a direct link to the official CSELab web page at 
http://www.cse-lab.ethz.ch. 

• Proper citation is essential to continued ETH Zurich funding for software 
development, as it is the primary way in which we demonstrate the value of our 
software to the scientific community. Thank you for your attention to these details. 

• The CSELab does not assume any responsibility for the SOFTWARE and the use of it. 
CSELab will not assume any liability for damages or loss of data occurring through 
the use of the SOFTWARE. CSELab does not guarantee the suitability of the 
SOFTWARE for any application. The LICENSEE will hold CSELab harmless for any 
claims on damages or loss of data which occur during the LICENSEE's use of the 
SOFTWARE. 

• CSELab does not guarantee that the SOFTWARE does not infringe any third party's 
intellectual property rights (including copyrights, patents, patent applications, 
publications or any other type of intellectual property right). The LICENSEE has to 
acquire on his/her own all necessary licenses and permissions for the use of the 
SOFTWARE if not otherwise agreed in writing. 

• In case the SOFTWARE is or will be under the physical control of the LICENSEE 
before this agreement is signed, CSELab gives consent to the use of the SOFTWARE 
under the condition of the LICENSEE's prior consent to this agreement. 

• This agreement is subject to Swiss law and ETH Zurich regulations. Place of 
jurisdiction is the Kanton of Zürich. 

• The TScratch program makes use of the CurveLab software (www.curvelet.org) and 
is subject to the license agreement provided in the file curvelab_license.txt included 
in this distribution. 

• The use and distribution of the MATLAB Compiler Runtime (MCR) libraries is 
subject to the MATLAB license agreement (see MCR_license.txt). In particular, the 
MCR may not be redistributed in any way separate from the SOFTWARE. 

 



2 Installation 

2.1  Mac ( Intel )  
TScratch only runs on Intel Macs, and has been tested with Mac OS X 10.5, but 
should also run with version 10.4. 
To install, follow the step-by-step instructions below: 
1. Unpack the TScratch_pkg file using “Archive Utility” or “StuffIt Expander”. 

The package contains the following files: 
• TScratch – the program file 
• run_TScratch.sh – script to run the program from a terminal window 
• TScratch_manual.pdf – this manual 
• MCRInstaller.dmg – installer for Matlab Compiler Runtime (MCR) 7.8 
• TScratchStandalone.scpt – Apple script to run the TScratch program 
• TScratch_icon.icns – icon file for TScratch 
• scratchicon_sm.png – icon image 
• point.png – image file required by the program 
• MCR_license.txt – license file for the use of MCR 
• curvelab_license.txt – license file for the use of CurveLab 
• readme.txt – information about MCR, including troubleshooting 

2. If you have not installed Matlab Compiler Runtime (MCR) version 7.8 on your 
computer before, do this by opening MCRInstaller.dmg and running 
MCRInstaller.pkg from the disk that becomes mounted. Remember the path 
where you install MCR. 

3. TScratch may now be run from a Terminal window using  
./run_TScratch.sh $MCRPATH$ 
when in the TScratch directory. $MCRPATH$ should be replaced by the path to 
MCR (such as /Applications/MATLAB/MATLAB_Compiler_Runtime/v78). 
The first time the program is started, it may take some time before the window 
appears – just be patient and wait, the next time it will be faster. 

4. To make things easier you can edit the script file TScratchStandalone.scpt 
using the “Script Editor” (just double-click on the file to open it) and replace the 
existing paths with your paths to run_TScratch.sh and to the MCR. Then 
choose “Save As…” and select “Application” and save the script in a suitable 
location. The TScratch program may now be run by double-clicking on this 
Application file, and may also be added to the dock. 

5. A program icon is included in the distribution in the files scratchicon.icns 
and scratchicon_sm.png. If  you would like to change the icon of the 
application, you need to use a program such as Pic2Icon (available from for 
example www.download.com). The perform the following steps: 
• Drag the file scratchicon.icns to the Pic2Icon conversion window. 
• Select scratchicon.icns in Finder and press ⌘I to show the “Get Info“ 

window. Check that the icon shown on the top left is showing the scratch 
assay image. Select this icon and press ⌘C to copy it. Open the “Get Info” 
window for the application file that was created in step 4 above. Select the 
icon at the top left and press ⌘V to paste the TScratch icon. Close the “Get 
Info” windows and the TScratch application should now have a beautiful 
icon. 

2.2  Windows 
TScratch has been tested on Windows XP, but should also run on Windows Vista. 
To install on Windows machines, follow the instructions below: 
1. Unzip the file TScratch_win.zip to extract TScratch_win.exe. 



2. Double-click on TScratch_win.exe to unpack the program files. The package 
contains the following files: 
• TScratch.exe – the program  
• TScratch_manual.pdf – this manual 
• MCRInstaller.exe – the Matlab Component Runtime 7.8 installer 
• scratchicon.ico – an icon file for the program 
• scratchicon_sm.png – icon image 
• point.png – image file required by the program 
• MCR_license.txt – license file for the use of MCR 
• curvelab_license.txt – license file for the use of CurveLab  
• readme.txt – information about MCR, including troubleshooting 

3. After unpacking, the file MCRInstaller.exe will be automatically executed to 
start the installation of Matlab Component Runtime (MCR) version 7.8. If MCR 
v7.8 is already installed on the computer, you may cancel the installation. 
Otherwise follow the on-screen instructions to install MCR. 

4. Once MCR has been installed, double-click on TScratch.exe to start TScratch. 
Add StartMenu, Desktop and Quickstart menu shortcuts manually if desired. 
The icon file scratchicon.ico may be used as an icon for these shortcuts. 



3 Quick start 
The basic workflow of the TScratch program follows the outline in Figure 3.1. 

 
Figure 3.1. The basic workflow of the TScratch program. 

A stepwise instruction for the simplest possible use of the TScratch program is as 
follows: 

1. Acquire images, saving them as JPEG or TIFF images (with extension .jpg or 
.tif respectively). If multiple time-points are acquired, save them in 
different subdirectories directly under one top directory, using the same file 
name for images taken from the same well. Additionally, use filenames of the 
form label_nr.jpg to group samples with the same label in the final 
analysis. The identifier nr can be anything, not necessarily a number, and 
space can be used instead of underscore. See Figure 3.2 for an example of the 
directory structure. See also sections 4.2, 4.5 and 10.2 for more information. 

 

 
Figure 3.2. Example of the directory and filename structure. 

 
2. Start the TScratch program as described in sections 2.1 and 2.2. The program 

window looks like in Figure 3.3, though no images will be shown until a data 
set has been loaded. For each step in this instruction, the red numbers in 
Figure 3.3 indicate the location of the controls referred to. 



 
Figure 3.3. The TScratch GUI (in single image mode). The numbers correspond to 
the numbers in the step-by-step instruction.  

3. Click the “Browse…” button next to the “Image directory” box and select the 
top directory containing your images (“Assay 080515/” in the example 
above). 

4. If analyzing a time series, check the “Analyze time series” check box. Then 
click the “Browse…” button next to the “First time-point directory” box and 
select the subdirectory containing the images for the first time-point (“0h/” in 
the example above). 

5. Click the “Run analysis” button to start the analysis. The program will now 
analyze all the images in the subdirectories at the first level below the top 
directory (in time-course mode, which is described here; see section 4.2 for 
more information). The results, together with the analyzed images, are 
written to data files in the top directory and in a subdirectory called 
“Analyzed/” in each of the subdirectories containing the segmented images 
(see section 5). The estimated remaining time for the analysis is shown. 

6. When all the images have been analyzed, the program enters “group editing 
mode”, where the thresholds determining the open area measurement may 
be adjusted for each of the analysis types (see section 4.4), except for type 1 
(since the algorithm found a threshold automatically for all images in 
group 1). A few sample images of each type are shown (the total number of 
images with that type is shown in parentheses next to the type number above 
the slider). Adjust thresholds using the sliders. Click “Reselect images” to 
select new sample images from each group. Click “Reset” under the slider to 
undo the changes. Click “Done” when satisfied. 

7. The program now enters “single image mode” (see also section 4.3), giving 
the possibility to browse through all the images and (a) exclude images 
where the analysis failed, (b) adjust thresholds for single images and (c) 
manually edit the marked area using the paint and polygon tools (see 
sections 7.4 and 7.5), if required. Images are excluded from the analysis by 
un-checking the check box next to the image, with the number of remaining 
images shown in a text box. Thresholds may be changed using the sliders, 
and individual images may be enlarged using the “View” menu (see section 



7.2). Selecting the tools in the toolbar gives the possibility to manually draw 
in the images, as well as zoom in into the images. Click “Reset” to revert to 
the original threshold, undoing any manual modifications. Click the “<” and 
“>” buttons to browse through the analyzed images (the numbers next to the 
images show the image number in the order they were analyzed), or “>>” 
and “<<” to move faster (16 images at a time) through the data set. “|<” and 
“>|” moves to the first and last images, respectively. Many keyboard 
shortcuts are available to speed up the process (see section 8 for a listing). 

8. When done, push the “Done” button and specify an output file for the data 
computed using the modified thresholds and excluded images. In addition, a 
bar diagram is shown for each time-point after the initial one, showing the 
percentage of open area compared to the initial time-point for each of the 
groups (determined by the file names). Error bars show the standard error of 
the mean, and the numbers next to the group names show the number of 
images used for the analysis in each group. The diagrams may be exported to 
pdf-files (and many other formats) by selecting File->Save in the menu and 
selecting PDF as output format. An example of the graph is shown in Figure 
3.4. 

 
Figure 3.4. Example of the graphical output of results from TScratch, showing 
means and standard errors for the different groups. 

9. The output text file may be opened in a spreadsheet program such as Excel, 
where the data may be further analyzed and presented (see section 5.2.1 for 
more information on the output file). 

  



4 Basic concepts 

4.1  Open area measurements  
Throughout this document and the TScratch program, we discern between two open 
area concepts: open image area and open wound area.  
The open image area is given as the percentage of an image that is not considered as 
occupied by cells by the algorithm. This value is computed for each analyzed image 
and is written to the output text files in both single directory mode and time-course 
mode (see section 4.2). 
In time-course mode, the TScratch program also computes the open wound area, 
which is the fraction of open image area at a later time-point compared to the initial 
time-point, again given as a percentage. That is, the open wound area after 24 hours is 
computed as 

[open wound area 24h] = 100 x [open image area 24h] / [open image area 0h]. 
This value is also written to the output file in time-course mode, and this is the value 
that all the statistical analysis is based on. 

4.2  Directory  s tructure and direc tory  modes  
The TScratch program has two different modes for finding and analyzing images, the 
single directory mode and the time-course/multiple directory mode.  
In single directory mode, the program searches the specified directory for image files 
and analyzes them, measuring the open image area in each of them and giving this 
as output (as percentage of the total image area), together with some data on the 
analysis.  
In time-course mode, the program searches the specified directory for subdirectories 
and analyzes the images in each of these directories separately, assuming that they 
are data collected at different time- points for the same wells. Images with the same 
filename in different directories will be treated as different time- points for the same 
well (see also section 4.5). The directory specified as first time- point directory in the 
program will be treated as holding images for the first time- point. The output in 
time-course mode is, first, the open image area for each image, and, second, the open 
wound area, i.e. the open image area at later time- points divided by the open image 
area at the first time- point. 

4.3  Program modes  
The TScratch program has three steps, or program modes. They are: initial analysis 
mode, group editing mode, and single image mode.  

4.3.1 Initial analysis mode 
In initial analysis mode (see Figure 4.1), the user selects the directory that contains the 
images to be analyzed, sets parameters affecting the analysis, and starts the analysis 
by pressing the “Run analysis” button, or, alternatively, loads a previously analyzed 
data set by pressing the “Load old analysis” button. After the data has been 
analyzed, or loaded, the program goes into group editing mode (unless this mode 
has been disabled, see section 6.1). 



 
Figure 4.1. The directory selection boxes and buttons in initial analysis mode. In 
the “Tools” menu, the analysis settings may be changed. Using the “Browse” 
buttons, the directories containing the images are selected. If the “Analyze time 
series” check box is checked, a subdirectory containing images for the first time-
point must be selected, and the program analyses data in time-course mode, 
otherwise a single directory is analyzed and no time point comparisons are made. 

4.3.2 Group editing mode 
In group editing mode (see Figure 4.2), thresholds for the analysis types 2 to 4 (see 
section 4.4) may be adjusted using the sliders, affecting the measured open image 
area for all images of the type in question. Thresholds for images of type 1 may not 
be adjusted in group editing mode, since for this group the program already found a 
suitable threshold (this threshold may be adjusted for each image in single image 
mode). The type is shown to the top left of the image, and the number of images of 
that type is shown within the parentheses. The program displays at most four images 
at a time, and the lines between images indicate which images belong to the same 
type. By clicking “Reselect images”, new images from each group are randomly 
chosen for display. When clicking “Reset thresholds”, all threshold offset are reset to 
zero, undoing all the adjustments. When “Done” is clicked, the modified thresholds 
are applied to all images of types 2 to 4, and the program then enters single image 
mode. 



 
Figure 4.2. The TScratch program in group editing mode. Thresholds may be 
adjusted using the sliders. Numbers to the left indicate the analysis type of the 
images and, in parentheses, the number of images of that type. Using the buttons 
on the top right, the user may reset changed thresholds, randomly select new 
images of the shown types, and move on to single image mode by clicking 
“Done!”.  

4.3.3 Single image mode 
In single image mode, (see Figure 4.3) all the analyzed images are shown four at a time. 
The number of the image is displayed on the top left. If necessary the user may 
choose to adjust images by (a) threshold adjustment, (b) image exclusion and (c) 
manual adjustments, depending on the number of available replicates, image quality 
and available time. 
(a) Thresholds can be adjusted using the sliders to increase or decrease the open 
image area marked by the algorithm.  
(b) Images can be excluded, if a small number of images gave unsatisfying  
segmentation results due to artifacts in the image or poor image quality. 
(c)  Images may be rescued by selecting the manual modification tools, paint tool and 
polygon tool, from the toolbar and use them to mark closed areas in the images. See 
section 7 for details on these tools.  
To move through the data set, use the arrow buttons at the top right, single arrow to 
move one page at a time, double arrow to move four pages, and the outermost pair 
of arrows to move to the first and last images. 
Changes are saved to the internal data files when the arrow buttons are clicked, 
when “Done” is clicked to finish the analysis, or when the user answers “Yes” to an 
explicit question from the program if it should save the changes (as happens when 
the user exits the program or exports data).  
Note also the possibility to enlarge one image at a time to make it occupy the whole 
lower part of the program window. See section 7.2 for more information. 
Also note the available keyboard shortcuts in section 8. 



When “Done!” is clicked, the program asks for a filename to write the final results to, 
and depending on if the directory mode is single directory or time-course, different 
data is computed and written (see sections 5.1.1 and 5.2.1). The output file can be 
easily imported into MS Excel or another spreadsheet program for further analysis. 
In time-course mode, a diagram (as in Figure 3.4) is also shown for each later time-
point, showing means, standard errors and number of images for all groups of 
images (see section 4.5 for image grouping). The diagram may be saved as a PDF by 
choosing “Save As…” in the File menu and selecting PDF as output format. 

 
Figure 4.3. The TScratch program in single image mode. Thresholds for individual 
images are modified using the sliders. Images may be excluded by un-checking 
the checkboxes or manually rescued using the tool bar and sliders. The numbers 
next to the images indicate their number in the order all images were analyzed. 
Using the “Prev” and “Next” buttons, the user moves between images, and with 
the “Done!” button, the analysis is ended and an output file is written. Using the 
toolbar, the open area may be manually modified (see section 7). 
 

4.4  Analys is  Types  
When an image is analyzed, it is assigned a type based on the ability of the 
automated threshold finder to find a threshold. The following table lists the different 
types: 
1 the threshold finder found a suitable threshold (see section 9.1) 
2 the threshold finder failed, the curve did not have the expected 

characteristics (i.e. not enough open area to determine threshold) 
3 the threshold finder failed, found a threshold outside the allowed range 
4 the threshold finder succeeded, but the image was very dark or very bright 
5 the image was manually edited using paint or polygon tools in single 

image mode (not assigned by the threshold finder) 
6 the threshold for the image was manually changed (in single image mode; 

not assigned by the threshold finder) 



For types 2 and 3, the default threshold (see section 6.2) is used instead. In the 
“group editing mode” of the TScratch program, the user may adjust the thresholds 
for all images with types 2, 3 and 4 in one go. This is useful if the default threshold 
was not set to a good value. 

4.5  Grouping of images  and  fi l ename match ing 
In time-course mode, the open wound area is computed for each imaged region 
comparing later time-points to initial time-points, and means and standard errors are 
computed for groups of images. The identification of which images to compare is 
based on the filenames of the images. For an example of a good setup of filenames 
and directories, see Figure 3.2. More detailed information on how filenames are 
matched and grouped is given below. 
To match later time-points to the initial time-point, the whole filenames are 
compared. For example, a file called ctrl_1.jpg in the “24h” directory will be 
matched to the file ctrl_1.jpg in the “0h” directory, and the open wound area will 
be computed using the open image areas computed for these two images. The 
comparison of filenames is not case-sensitive, but all characters up to the file 
extension have to match (though different file extensions, and thus file formats, 
could be used for the two images). 
To group images into the groups used for statistical analysis, only the part of the 
filename up to the first underscore ‘_’ or space character ‘ ’ (or the ‘.’ separating the 
extension) is considered. Therefore, images called “ctrl_1.jpg”, “ctrl_2.jpg” 
and “ctrl 3.jpg” will be put in the same group (called “ctrl”), while 
“treated_1.jpg” and “ctrl1.jpg” will not. Again, the comparison is not case-
sensitive, but all other characters have to match up to the first underscore or space; 
all subsequent characters are ignored and may consist of any number of spaces and 
underscores. No attempt is made to correct misspelled filenames, so be careful that 
all the images are named correctly! 
Alternatively the extracted open image areas in the output file can be used directly 
(without the statistical and graphical analysis) and processed by the user. 



5 Output files 

5.1  Singl e direc tory  mode 
In single directory mode, the following output files are written: 

• TAB-separated text file with open area measures 
• <<filename>>_analyzed.<<ext>> for each image, in the “Analyzed/” 

subdirectory. <<ext>> is the same extension and file format as for the 
original image 

• all_data.mat in the “Analyzed/” subdirectory (for internal use by the 
program, see section 5.4) 

• <<filename>>_data.mat for each image, in the “Analyzed/” subdirectory 
(for internal use by the program, see section 5.5) 

Here, <<filename>> stands for the filename (without extension) of each analyzed 
image file. 

5.1.1 Output text file layout 
The output text file in single directory mode is a TAB-separated text file containing 
the columns “File name”, “Open image area”, “Threshold value” and “Image type”. 
All analyzed images are listed with their corresponding values in the order they 
were analyzed. See sections 4.1 and 4.4 for more details on the meaning of these 
numbers. 
At the bottom of the file, some information about the analysis is given, including 
date, directory and values of the most important parameters (see section 6.2). 

5.2  Multiple dir ectory  (t ime-course ) mode 
In multiple directory mode, the following output files are written: 

• TAB-separated text file with open area measures, open area ratios and 
statistical analysis of image groups. 

• <<filename>>_analyzed.<<ext>> for each image, in the “Analyzed/” 
subdirectory. <<ext>> is the same extension and file format as for the 
original image 

• global_data.mat in the base directory (for internal use by the program, 
see section 5.3) 

• <<filename>>_data.mat for each image, in the “Analyzed/” subdirectory 
(for internal use by the program, see section 5.5) 

Here, <<filename>> stands for the filename (without extension) of each 
analyzed image file. 

5.2.1 Output text file layout 
The TAB-separated output file in time-course mode has the following structure: 
For each matching pair of images, the open image area for all time-points is given, as 
well as the open wound area comparing later time-points to the initial time point. 
The columns are given headers like “0h” and “24h” (the names of the subdirectories) 
for the open image areas, and “24h vs. 0h” for the open wound areas (comparing the 
“24h” measurement to the “0h” measurement). 
In the next section of the output file, means, standard deviations, number of images 
and standard errors of the mean (SEM) are presented for all the groups of images, 
including the group names. Separate tables are created for each later time-point. 
Next, P-values for two-sided t-tests with unequal variance are given in a table 
comparing every possible pair of groups. A P-value of less than 0.05, say, indicates 
that the difference between the two groups is statistically significant at the 5% level. 
Again, a separate table is given for each later time-point. If a group of images 



contains only one image, the t-test involving this group is invalid and the value NaN 
(Not a Number) is shown. 
Finally, information about the analysis, including date, directory name and basic 
parameter values (see section 6.2) are given in the last section of the output file. 

5.3  File s tructure:  global_data.mat 
This file is used internally by the program to save the details of the analysis in time-
course mode. The file is saved in MATLAB mat-file format, and could be opened 
using the MATLAB load command (if the full version of MATLAB is installed). The 
user is not supposed to modify this file, and will normally not need to look at it. For 
the interested, however, it includes the variables 
version real number giving the version of the program producing the 

file 
t0diridx index into the diridx array of the time 0 directory 
diridx indices into fnames cell array of the first file of each directory 
fnames cell array with the filenames of all analyzed files, preceded by 

the subdirectory, e.g. “0h/image.jpg” 
areas column vector with computed open areas (in [0,1]) for each file 
ths column vector with the threshold used for analyzing each file 
types column vector with the type for each analyzed file 
opts an options structure with all the parameters used for the 

analysis 
Table 5.1. The variables contained in global_data.mat. 
 

5.4  File s tructure:  al l_data.mat 
This file is used internally by the program to save the details of the analysis in single 
directory mode. The file is saved in MATLAB mat-file format, and could be opened 
using the MATLAB load command (if the full version of MATLAB is installed). The 
user is not supposed to modify this file, and will normally not need to look at it. For 
the interested, however, it includes the variables 
version real number giving the version of the program producing the 

file 
fnames cell array with the filenames of all analyzed files, e.g. 

“image.jpg” 
areas column vector with computed open areas (in [0,1]) for each file 
ths column vector with the threshold used for analyzing each file 
types column vector with the type for each analyzed file 
opts an options structure with all the parameters used for the 

analysis 
Table 5.2. The variables contained in all_data.mat. 

5.5  File s tructure:  <<fi l ename>>_data.mat  
These files are saved for each analyzed image, in the “Analyzed/” subdirectory. 
They are used internally by the program to save analysis data for individual images, 
and are save in MATLAB mat-file format. The user should not manually modify or 
delete these files. They include the variables 
version a real number giving the version of the program saving the file 
opentotmag the opened curvelet magnitude image 
thresh the threshold used for the image 
itype the analysis type of the image 
Table 5.3. The variables contained in <<filename>>_data.mat. 



6 Parameters and options 
All program options and analysis parameters may be set in the Settings window (see 
Figure 6.1), which is opened by selecting “Settings…” in the Tools menu, or pressing 
Ctrl-S (⌘S on Mac). The options are divided into three groups: Program settings (see 
section 6.1) that affect the behavior of the program, Basic analysis settings (section 
6.2) with major effect on the image analysis, and Advanced parameters (section 6.3) 
that affect the threshold finding and image analysis and should not normally be 
changed. 
In the Settings window, checking the box “Display advanced options” shows the 
advanced options, which are hidden by default. “Reset” restores the default values. 
With “OK” the chosen parameters are saved to a file and are used for the current 
analysis, as well as loaded the next time the program is started. 
If the Settings window is opened while in “group editing mode” or “single image 
mode”, some choices are disabled since they affect only the initial analysis. If the 
parameters are changed while in these modes, the new parameters are directly 
applied to all images in the analyzed set. This may take a while, and the remaining 
time is shown in the status box. 
 

 
Figure 6.1. The settings window. 

6.1  Program se tt ings  
The following program settings are available: 
Write analyzed images Disabling this option prevents the program from 

writing the analyzed images with an overlay showing 
the closed area to files in the “Analyzed” directory. This 
may be useful to save disk space. 

Skip group editing mode Enabling this option makes the program skip the 
“group editing mode” and go directly to the “single 
image mode”.  

Display analysis curve Enabling this option makes the program display a 
histogram curve for each analyzed image, indicating the 
chosen threshold. This is useful to see why the program 
fails on certain images and to evaluate the advanced 
parameters. 

 



6.2  Basic analys is  sett ings  
The basic analysis parameters are the ones that affect the analysis most. Therefore, 
they are also the ones that the user most likely needs to change. Below follows a 
description of their meaning, and some instructions on when to change them. 
The basic analysis parameters have the following meaning: 
Default threshold This is the threshold used if the automatic threshold 

finder fails, i.e. for analysis types 2 and 3. A lower 
threshold gives less open area. The ideal default 
threshold may  depend on the cell line morphology. Since 
the thresholds for images of type 2 and 3 may be 
modified in group editing mode (see section 4.3), it makes 
most sense to change this value if several experiments are 
made with one cell line, using the same image acquisition 
settings, and it is noted that one particular default 
threshold works better for these settings. 

Disk radius The radius of the disk used for the morphological 
opening of the curvelet magnitude image. A smaller disk 
size makes the analysis more sensitive to small gaps 
between cells, and to isolated impurities, but may on the 
other hand give tighter contours for the marked area. 
This value could be increased if the cells are sparsely 
packed, to avoid getting holes inside the closed area. 
Decrease the value if tighter edges are desired (with less 
margins on the closed area), but be aware that a too small 
value may influence the threshold finder, making it 
harder to automatically find a threshold. 

Minimum hole area The smallest fraction of the largest open area in the 
analyzed image that is allowed to be open. Smaller 
isolated open areas are filled. 
Increase this value if the program leaves holes in the 
closed area that should be marked as closed, decrease it if 
the program erroneously marks small open areas as 
closed. 

Minimum island area The smallest fraction of the largest closed area that is 
allowed to be closed. Smaller isolated closed areas are 
removed. 
Increase this value if the program leaves “islands” of 
closed area due to artifacts or debris. Decrease it if the 
program erroneously marks entire areas occupied by cells 
as open. 

Erosion size The amount of erosion applied to the marked closed area 
after the thresholding. A zero value means nothing is 
done, and a large value means more closed area is 
removed at the boundaries. The exact number of pixels 
removed for a specific erosion size depends on the 
curvelet analysis, and therefore on the image resolution. 
Increase this value if an analysis with edges tighter to the 
cell boundaries is desired. Decrease it if the edges are too 
tight, so that the marked open area overlaps with the area 
actually occupied by cells. 

Background 
compensation 

When this box is checked, the program tries to 
compensate for large variations in background intensity 
that may otherwise affect the results. If the images to be 
analyzed have even lighting, this option may as well be 
disabled, making analysis slightly faster.. 

 



6.3  Advanced parameters  
The advanced parameters mainly affect the automatic threshold finding and have the 
meaning described in the table below. The threshold finder uses the histogram of the 
curvelet magnitude image and looks for a local minimum between two large peaks 
(local maxima), referred to as the first and second max. The average user should not 
need to bother about these parameters. 
Difference to global min The smallest difference allowed between the value in 

the histogram for the chosen threshold and the global 
minimum value (within the allowed range). 

Bump size The smallest difference in histogram value between a 
local minimum and a subsequent local maximum that 
makes the algorithm choose the local minimum as 
threshold. 

Lower threshold limit The lower bound for the threshold (if a smaller value is 
found, the image is assigned type 3). 

Upper threshold limit The upper bound for the threshold (if a larger value is 
found, the image is assigned type 3). 

Upper first max limit The upper limit for the location of the first maximum. 
(Failure assigns type 2 to image) 

Lower second max limit The lower limit for the location of the second maximum. 
(Failure assigns type 2 to image) 

First max minimum 
height 

The minimum height needed to consider a local max as 
first maximum. (Failure assigns type 2 to image) 

Max to min difference The minimum allowed difference between the 
maximum found and the global minimum between the 
two maxima. (Failure assigns type 2 to image) 

Dark image threshold Threshold used to assign images type 4 (=large intensity 
variation image). Larger value makes it harder to be 
assigned type 4. 

Threshold offset An offset added to all automatically determined 
thresholds. 

 



7 The toolbar 
At the top of the TScratch window is the toolbar and the menu bar (Figure 7.1). The 
menu bar contains the “Tools” and “View” menus, while the toolbar contains several 
different tools. The drawing tools are only made available in single image mode. 
There are also keyboard shortcuts for all the tools, as tabulated in section 8. Below we 
describe the tools one by one. 
 

 
Figure 7.1. The TScratch toolbar containing the “Tools” and “View” menus, zoom 
and pan tools, the paint and polygon tools and the undo/redo buttons (from left to 
right). 

7.1  The Tools  menu 
The Tools menu contains five items: “Export analysis data”, “Statistics…”, 
“Settings…”, “About…” and “Exit”.  
Selecting “Export analysis data” opens a window that allows the user to select a 
filename for writing a text file containing names, measured open image area, 
threshold (unless manually analysed) and analysis type for all the analyzed images, 
as well as information about the parameters used for the analysis. The output file 
structure is similar to the one generated in single directory mode (see section 5.1.1).  
The “Statistics…” item displays a window with some statistics on the analyzed data 
set, containing the number of images of each type. The “Settings…” item opens the 
settings window for changing parameters (see section 6), the “About…” item shows 
information about the authors and the program version, and the “Exit” item, 
obviously, quits the program. Keyboard shortcuts are shown next to the menu items. 

7.2  The View menu 
The View menu contains the item “Goto image number…” and five items related to 
enlarging one of the images in single image mode. “Goto image number…” is active 
only in single image mode, and opens a dialog box where the user can enter the 
number of an image to display (along with the next three images, if possible). 
Entering a number out of range generates an error.   
The items “Enlarge image #” make image 1 to 4 be displayed on the whole bottom 
part of the program window, enabling a closer investigation of the analysis and more 
accurate manual editing. To go back to viewing four images, select the same menu 
item again (it has now changed to “Reduce image #”) or select “Reset to 4-image 
view”. There are also keyboard shortcuts for these menu items: ‘1’–‘4’ for 
enlarging/reducing images and ‘0’ to go back to 4-image view. 

7.3  The zoom and pan tools  
The zoom tools (the +/- magnifying glasses) enable the user to zoom in into the 
images and back out. Left-clicking in an image with a zoom tool enabled zooms 
in/out depending on the tool selected. Double-clicking resets to the original size. 
Right-clicking brings up a context menu where a few options may be selected, and 
left-clicking and dragging draws a rectangular area which is what is shown when the 
mouse button is released. 
The pan tool (the hand) can be used to move the zoomed in area by left-clicking and 
dragging to move the image. 



See also the keyboard shortcut section (section 8) for shortcuts for these tools, as well 
as information on how to zoom and pan without switching tools (using the ‘+’, ‘-‘, ‘*’ 
and arrow keys). 

7.4  The paint  tool  
When the paint tool (the brush) is selected and the mouse pointer is moved over one 
of the images, the pointer turns into a circle. Left-clicking in the image now draws a 
covered area (indicated by brightening the image), while right-clicking removes 
covered area (or draws open area). Clicking and dragging draws continuous lines 
with the width of the circle. The response may sometimes be a bit slow depending on 
the computer, so do not drag the mouse too quickly.  
When an image is modified using the paint tool, its type is changed to 5, indicating 
that it was manually edited, and the open image area displayed above the image 
(and printed in the output file) is updated every time the mouse button is released. If 
the user then tries to change the threshold for the manually edited image, a warning 
is shown that this action will remove the manual modifications, and if the user 
proceeds, the image type is changed to 2 and the image is again automatically 
analyzed with the previous threshold and the modified offset. 
If the image is zoomed in, the painting tool becomes more detailed, with the painted 
area always corresponding to the size of the circular mouse pointer. Here, it is 
especially useful to take a look at the keyboard shortcuts for zooming in section 8. 
All changes using the paint tool may be undone with the undo tool. 

7.5  The polygon tool  
Using the polygon tool (the polygonal shape in the toolbar), the user may manually 
analyze images by drawing polygons enclosing regions of open area. To do this, 
select the polygon tool, then click in the desired image – the mouse pointer now 
changes to a cross-hair symbol – then left-click repeatedly in the image to add nodes 
to the polygon. Double-clicking places one last node and closes the polygon by 
connecting it to the first node placed, while right-clicking does not add a new node, 
but connects the previously placed node to the first one to close the polygon. 
After the last node has been placed, the area enclosed by the polygon is marked as 
open and the area outside as closed, and the percentage of open image area is 
updated accordingly. Several polygons may be drawn after one another, each of 
them enclosing an open area but not overwriting each other, but as soon as the “<” 
or “>” buttons are clicked to move between image views, or the paint tool is used, 
the previous polygons are lost (only the resulting open area is kept) and drawing a 
new polygon will start the procedure from the beginning. 
Polygons drawn using the polygon tool can be undone using the undo tool. 

7.6  The undo/redo  tools  
The undo and redo tools (curved arrows backward and forward) can be used to 
undo (and redo) manual modifications using the paint and polygon tools. They work 
for all four displayed images at the same time, meaning that if image 1 is changed 
and then image 2 and image 1 again, repeatedly clicking the undo tool will undo 
changes in exactly this order, though backwards, (and not all changes to image 1 
first, then image 2, etc.). Changes that are undone using the undo tool may then be 
re-done with the redo tool. 



8 Keyboard shortcuts 
The following keyboard shortcuts are available (if the corresponding tools/menu 
items are activated): 
 
Menu item shortcuts 
Ctrl-D (⌘D on Mac) Export analysis data for all analyzed images (section 7.1). 
Ctrl-T (⌘T on Mac) Show the statistics window. 
Ctrl-S (⌘S on Mac) Open the Settings dialog (section 6). 
Ctrl-A (⌘A on Mac) Open the About box. 
Ctrl-E (⌘E on Mac) Exit the program. 
Ctrl-G (⌘G on Mac) Go to image number in single image mode. 
0 Return to 4-image view (single image mode only). 
1–4 Enlarge/reduce image 1–4 (single image mode only). 
Tool shortcuts 
Z Select/deselect the zoom in tool. 
X Select/deselect the zoom out tool. 
C Select/deselect the pan tool. 
O Select/deselect the paint tool. 
P Select/deselect the polygon tool. 
U Undo. 
R Redo. 
Button shortcuts 
N Next (equivalent to “>” button) 
Alt-N Jump 4 pages forward (equivalent to “>>” button) 
M Last page (equivalent to “>|” button) 
B Previous/Back (equivalent to “<” button) 
Alt-B Jump 4 pages forward (equivalent to “<<” button) 
V First page (equivalent to “|<” button) 
Zoom/pan shortcuts 
+ Zoom in into the current image by a factor of 1.7. 
- Zoom out of the current image by a factor of 1.7. 
* Reset current image to original view. 
Arrow keys (←,↑,→,↓) Move around in the current, zoomed in, image. 

Table 8.1. The keyboard shortcuts for the TScratch program. 
The “current image” referred to in Table 8.1 is the image that was latest clicked in 
using any of the tools, or no tool at all. 
Additionally, the TAB key may be used to move focus between buttons, edit boxes 
and check-boxes in the GUI, and the SPACE bar and RETURN key may be used to 
check/uncheck check-boxes and press buttons. If an edit box has focus, the keyboard 
can be used to write text in it, and the shortcuts in Table 8.1 will not work until 
another component has the focus. 



9 Computational details 

9.1  The open area  measurements  
In this section, the algorithm for measuring the open image area is described in more 
detail, giving an idea of how the image analysis works. The basic idea is to use the 
multi-resolution curvelet transform to extract information on the detail levels 
corresponding to cells in the image, and then separating the regions with much 
detail (covered area) from regions with little detail (open area) by choosing an 
appropriate threshold. The implementation was done in MATLAB, using some of the 
built-in MATLAB functions. 
The computation of open image area consists of the following steps: 

1. Compute the mirror-extended curvelet transform 
2. Extract two levels from the curvelet transform, and sum coefficient 

magnitudes over directions and levels 
3. Optionally scale for large intensity variations 
4. Compute the morphological opening of the image using a specified disk size 
5. Automatically find a good threshold for the image 
6. Apply the found threshold, or a default threshold if none found 
7. Apply an erosion transformation to remove spill-out covered area 
8. Fill isolated open areas (“holes”), and isolated covered areas (“islands”) 
9. Compute the fraction of open area compared to the total image area 

The mirror-extended curvelet transform [1, 2] is computed using CurveLab 
(www.curvelet.org). The use of the mirror-extended version of the curvelet 
transform ensures that no artifacts are introduced by the image boundaries. The 
result is curvelet coefficients 
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The magnitudes of the curvelet coefficients on the two selected levels are then 
summed over levels and directions to produce the curvelet magnitude image 
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The compensation for large intensity variations is performed by using the coarsest 
scale of the curvelets, and multiplying the curvelet magnitude image by 
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coarsest scale of curvelets, and normalized to be between 0.0 and 1.0.  
The morphological opening is computed using the MATLAB command 
imopen(cmim, strel(‘disk’, radius)), where cmim is the curvelet 
magnitude image and radius is the parameter disk radius that may be set by the 
user (see section 6.2). 
The threshold used to separate open and covered area is automatically determined 
by investigating the histogram of the curvelet magnitude image, smoothing it 
slightly and looking for a threshold between two peaks in the histogram. Parameters 
affecting the threshold finder are discussed in section 6.3, but should hardly need to 
be changed by the user. This works well when the open and covered areas both have 
a significant size (thereby producing large peaks in the histogram), but when either 
of them is very small or the image is of bad quality, the automated threshold finder 
may fail, and instead the default threshold (see section 6.2) is applied. The threshold is 



applied by marking areas with curvelet magnitude larger than the threshold as 
covered, and areas with smaller curvelet magnitude as open. 
An erosion transformation is then applied to the thresholded image by the MATLAB 
command bwmorph(thim, 'erode', erodesize), where thim is the 
thresholded image and erodesize is the parameter erosion size (see section 6.2). 
Since a connected open area is desired, the algorithm also fills “holes” and removes 
“islands” if they are smaller than [minimum hole area] * [largest connected open area] 
and [minimum island area] * [largest connected covered area], respectively. The 
parameters minimum hole area and minimum island area can be set by the user (see 
section 6.2). 
Finally, the open image area percentage is computed as  
100*(1 – [# covered pixels]/[total # pixels]). 
 

9.2  Statis t ical  analys is  
The statistical analysis of the groups of images in time-course mode consists of the 
following entities: 

• Mean value, µ 
• Standard deviation (unbiased), σ 
• The number of images, N, belonging to the group 
• Standard error of the mean (SEM), σ/√N 
• Student’s T-tests 

The bars in the diagram shown by the program (see Figure 3.4) represent the means 
of open wound areas for the groups, with error bars indicating SEM. The number of 
images is shown in parentheses after the group names. 
The t-tests are computed for all pairs of image groups, and are two-sided tests with 
unequal variance. The numbers given in the output file are P-values giving the 
probability that the images in the two groups stem from the same distribution. Thus, 
a P-value of less than 0.05, say, means that the difference between the groups is 
statistically significant at the 5%-level. The P-values are computed using the 
MATLAB function ttest2. 
 



10 Tips for experimental setup 
Below are some suggestions on how to set up the wound healing experiment and 
image acquisition to make the TScratch program perform well on the images. The 
automated analysis is more dependent on a good image quality than a manual 
analysis is, but spending some time on making high quality images easily saves a lot 
of time on the analysis. 

10.1  Tips for  the  wound healing exper iment 
 
The wound healing assay is a cheap and widely-used image-based migration assay 
that assesses coverage of a cell-free, open area by migrating cells from a confluent 
area. Even though there are many protocols available [4], especially online, these 
suggestions can maximize the observed effect: 

• Seed the cells at full confluence and let them attach, depending on the cell 
line for 2 h to 24 h. 

• Starve the cells overnight in serum-free or serum reduced medium (1 % 
serum), depending on the sensitivity of the cell line. 

• Scratch confluent cell layer once horizontally and twice vertically 
for each well, producing two crosses with a good distance from 
each other and the well’s rim. Using a 200 µl pipette tip and the 
lid of the culture plate as a ruler for straight lines worked very 
well for us. Homogenous cross sizes are the key for replicates with 
low variance. 

• Thoroughly wash the cells with PBS and carefully swirl the plate before 
applying the treatment to remove cells detached by scratching. 

• Acquire “0 h images” and apply treatments directly after scratching. 
 

10.2  Tips for  image  acquis it ion 
Any conventional light microscope with attached camera can be used. To achieve 
good results and make the analysis process run as smoothly as possible, it is 
recommended to consider the following sample preparation and image acquisition 
tips.  

• Whenever possible images should be acquired in minimal, Phenol Red-free 
medium or best PBS to minimize floating debris or serum residues that can 
add artifacts to images. 

• Acquire images with 5X magnification and perfectly centered crosses. 
• Consistently name the images, like “condition_replicate#_cross#”, and make 

sure to have identical names for each sample at each time point saved in 
separate folders, e.g. 0h and 24h (see Fig. 2.1). 

• Maximizing the contrast is the key. 
o For us, using phase-contrast or bright-field with nearly closed 

aperture gave the best results. 
o Keep the image slightly unfocussed to acquire an image plain on top 

of the focus plain (see Figure 11.1). 
o If the used image acquisition software supports this, chose an 

“automatic min/max” contrast option. 
• Adjust the brightness of your lamp so that an exposure time of 15 ms to 100 

ms gives you satisfying brightness for the acquired image. 
• The algorithm deals better with slightly overexposed, brighter images than 

too dark images. 
• Try to have an homogenous light distribution throughout the whole image, 

preventing brightness gradients. This can be achieved by recalibrating the 
light path to Kohler illumination (see your microscope’s instruction or this 
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interactive java tutorial 
http://www.microscopyu.com/tutorials/java/kohler/ ). 

• Try to reduce image acquisition time outside the incubator to 30 min at a 
maximum for preventing effects on cells. 

 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 11.1. Contrast maximization in image acquisition. For ideal image 
acquisition the area of interest  should be slightly unfocussed. While the contrast 
can be enhanced by imaging below the focus plain (A), TScratch performs best 
with imaging on top of the focus plain (B). 
 



11 Troubleshooting 
Below are some common problems that can be encountered and suggestions for their 
solution. 
 
Question Answer 
The program does not 
start. 

Mac: The first time the program is run, it may take a while 
before the program window shows up. Just be patient and 
wait – the next time it will be faster. 
If the program still does not run, make sure that:  
• MCR v7.8 was properly installed 
• If you use the startup script, make sure that you 

entered the correct paths to MCR and the 
run_TScratch.sh file, inside quotation marks. Run 
the script from the Script Editor to see any error 
messages. If you have trouble with the script, or saving 
it as an application, you may always run it from a 
Terminal window by entering 
cd $TSCRATCH_PATH$ 
./run_TScratch.sh $MCR_PATH$ 
where $TSCRATCH_PATH$ and $MCR_PATH$ should 
be substituted to the paths to the TScratch program and 
the MCR, respectively (within quotation marks if they 
contain spaces). 

Windows: If the program does not start, the most likely 
cause is that there was some problem with installing MCR. 
Try reinstalling MCR and pay attention to any error 
messages. 

The program fails to 
analyze my images. 

Although much effort has been put into creating a robust 
and flexible algorithm, the algorithm still depends on a 
good image quality to be able to analyze the images. Be 
sure to read section 10 to get some suggestions on how to 
acquire images.  
Depending on the morphology of cells in the images, it 
may also be necessary to change some program parameters 
(see section 6). Start with changing the disk radius and 
disabling/enabling background compensation, and see if the 
results get better. 
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